
Chapter 1: Getting to Know 
Adobe Flash

In This Chapter
� Understanding how Flash differs from other Web technologies

� Exploring the Flash environment

� Introducing Flash tools

� Exploring the Properties inspector and panels

� Customizing your Flash workspace

Vive la différence! That’s the expression that Web site designers and
users have long used about Adobe Flash (formerly Macromedia Flash).

In an environment in which standards-based solutions (HTML, CSS, and
JavaScript, for example) have long been insisted on and proprietary tech-
nologies have been shunned, Flash stands alone. It’s proprietary. It doesn’t
do much with HTML or JavaScript or CSS. Yet, because of its ability to play
multimedia over the Web and provide a great user experience, Flash movies
are as much a part of the Web as HTML is.

It’s time, therefore, for you to jump on board and embrace Flash to help you
create your Web site. You can use this chapter as a jumping-off point. We
start by taking you on a guided tour through the various parts of the Flash
development environment.

Like Dreamweaver (see Book IV), Flash is available for both the Microsoft
Windows and Mac OS X platforms. The screen shots in this book are from
the Mac version, but all the instructions are for both operating systems.

A Matter of Timing: Making the Mind Shift to Flash
The expression Vive la différence! is not only appropriate for Web site visi-
tors but also suitable for you as you design and create Web sites. Flash is
definitely much different from the other technologies you explore in this
book.
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HTML is designed to display content on the Web. CSS comes alongside and
helps you present that content in a user-friendly manner. Enter JavaScript. It
can be used to perform certain interactive actions when an event on the
page is triggered. However, even though each of these technologies, when
added together, form a more complex solution, they are all fairly linear in
how you create them.

Flash, however, introduces you to the added dimension of time. Everything
in a Flash movie that you work with is coordinated with time. Animations,
movie loops, sound effects — each of these elements is introduced in a Flash
movie based on a timeline you manipulate.

Much like a motion picture, a Flash movie is a series of frames that are 
displayed rapidly in succession (often, 12 frames per second), giving the
appearance of animation or motion. Suppose that you place an image in a
different position for each frame of a movie. When the movie is played back,
the image gives the illusion of being in motion.

This added element of time is a factor that you need to wrap your mind
around as you begin to work with Flash. For many people, this concept takes
some getting used to.

Introducing the Flash Workspace
When you first launch Flash, you see a Welcome screen, like the one shown
in Figure 1-1. From this screen, you can get started in creating a new Flash
file, opening an existing file, or creating a new file based on a sample.

By default, the Welcome screen appears every time you start Flash. To
bypass this window, however, select the Don’t Show Again check box 
before proceeding.

Click either the Flash File (ActionScript 3.0) button under the Create New
section or any other option you want to select. The new file is created inside
the Flash workspace (see Figure 1-2).

You compose and design layers for your Flash movie by drawing or inserting
objects into the Stage, which is a drawing area. (See Chapter 2 in this mini-
book for more on the Stage.) These layers are then added to the Timeline as
frames. Each panel that surrounds the Stage window is used in the develop-
ment of your movies.
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Figure 1-2:
The Flash
develop-
ment
environ-
ment is
tailored for
designing
and
animating
movies.

Figure 1-1:
Welcome to
Flash. We
hope you
enjoy your
stay.
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Exploring the Flash Drawing Tools
To create or modify drawings, images, and text in the Stage, you work with
the drawing tools in the Tools panel (shown in Figure 1-3). Some buttons
have drop-down arrows that display additional tools. When you select a tool,
the Options section at the bottom of the Tools panel is updated to provide
options for the selected tool.

Table 1-1 lists the available tools and describes what they do.

If you have worked with Adobe Photoshop, you have a head start. Many
Flash tools are similar to what you’ve already used in Photoshop.

Table 1-1 Flash Tools
Tool What You Use It For

Selection Select an object in the Stage.

Subselection Select, drag, and reshape an object by using anchor points 
and handles.

Free Transform Transform (scale, rotate, skew, or distort) an object.

Gradient Transform Transform a gradient or bitmap fill object.

Lasso Select an object by drawing a lasso around it.

Pen Draw straight lines and curves.

Add Anchor Point Add an anchor point for drawing.

Delete Anchor Point Remove an anchor point.

Rectangle
Brush
Paint Bucket
Eraser
Zoom

Fill Color
No Color

Text
Lasso
Subselection

Options selection
for selected tool

Selection
Free Transform

Pen
Line

Pencil
Ink Bottle

Eyedropper
Hand

Stroke Color

Black/White
Swap Color

Figure 1-3:
The Tools
panel gives
you many
selection,
painting,
and drawing
tools.
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Tool What You Use It For

Convert Anchor Point Convert an anchor point for drawing.

Text Create text.

Line Draw straight lines.

Rectangle Draw rectangles.

Oval Draw ovals.

Rectangle Primitive Draw primitive rectangles.

Oval Primitive Draw primitive ovals.

Polystar Draw a polygon or a star.

Pencil Draw lines and shapes.

Brush Paint brush strokes.

Ink Bottle Change the color, width, or style of lines or shape outlines.

Paint Bucket Fill a closed shape with a solid color or gradient.

Eye dropper Copy the color of an object and apply it to another one.

Eraser Erase strokes, lines, and fills.

Hand Move the entire movie area in the Paste board.

Zoom Change the magnification level of the Stage.

Exploring the Properties Inspector
The Properties inspector, shown in Figure 1-4, displays the properties of 
the document or the selected object in the Stage. The Properties inspector
contains these three tabs:

✦ The Properties tab sets the commonly accessed properties of the
selected object.

✦ The Filters tab is used for applying special-effect filters to text, movie
clips, and buttons.

✦ The Parameters tab is used only when working with components.

Figure 1-4:
The
Properties
inspector.
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Exploring the Flash Panels
Surrounding the Stage and Timeline window are several panels that are used
for a variety of tasks in the movie creation process. These panels can be dis-
played in their own floating windows or grouped together into panel groups.
A panel that’s docked with a group appears as a tab inside the panel group
window. You can access each of these panels from the Window menu.

Each panel has a drop-down menu on its right side that displays various
available commands related to the panel.

Flash has more panels than you can shake a stick at. The following sections
describe the ones you most commonly work with, organized by purpose.

Media components and elements panels
The three panels used for working with assets of a movie are described in
this list:

✦ Components: The Components panel (shown in Figure 1-5) is used to
add various user interface, multimedia, or data controls to your movie.

✦ Movie Explorer: The Movie Explorer (see Figure 1-6) provides a visual
hierarchical tree display of your movie showing the various elements
(text, buttons, movie clips, and graphics, for example) that are in use.
The Movie Explorer can be a handy way to take a big-picture look at a
Flash movie (to see all the elements included in it) or as a way to search
for a particular element.

Figure 1-5:
Drag and
drop your
component
onto the
Stage.
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✦ Library: The Library (see Figure 1-7) contains media assets (movie clips,
sounds, graphics) that you either create or import. It can also contain
symbols, which are graphics, buttons, or movie clips that you create
once and then reuse. You can use the Library to manage the assets.

Design panels
Five main panels are used as aids in the design process (see Figure 1-8):

Figure 1-7:
The Library
stores your
media
assets.

Figure 1-6:
The Movie
Explorer
gives you a
big-picture
view of your
movie
compo-
nents.
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✦ Color: The Color panel is used for setting the Stroke or Fill color.

✦ Info: The Info panel provides size and x,y position information about the
selected object.

✦ Swatches: The Swatches panel helps you manage color sets.

✦ Align: The Align panel is used to align, distribute, and match the size
and spacing of selected groups of objects.

✦ Transform: The Transform panel is used for rotating, skewing, or scaling
the selected object.

Figure 1-8:
Design
panels help
you as
you’re
creating
your movies.
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Scripting panels
Two panels are related to scripting your movie:

✦ Actions: The Actions panel (shown in Figure 1-9) is used for working
with ActionScript scripts within a movie.

✦ Behaviors: The Behaviors panel contains predefined scripts that you
can use to add animation to your movie.

Customizing Your Workspace
The sheer number of various panels and windows that you can work 
with in Flash can make your workspace difficult to manage. However, like
Dreamweaver (discussed in Book IV), you can use Flash to customize your
working environment to position windows just the way you like and then to
save your workspace for future use.

Figure 1-9:
ActionScript
can add
power and
interactivity
to your
Flash movie.
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Showing and hiding a panel
You can access all the panels from the Window menu. You can show or hide
a panel by selecting its menu item from a list. You can also hide a panel
that’s open by clicking its Close button.

Pressing F4 toggles the visibility of all panels and inspectors. This shortcut
is useful when you want to eliminate distractions as you create, test, or pre-
view your Flash movie.

Adding a panel to (or removing a panel from) 
a panel group
Each panel can be combined with others to form a panel group. A panel
group can be arranged as tabs, such as the panel group shown in Figure 1-10.
To add a panel as a tab, simply drag the panel on top of another panel. When
you release the mouse, Flash adds the panel as a new tab.

Alternatively, you can arrange panels on top of each other (such as the
design panels shown in Figure 1-8). To add a panel above or below another
panel, drag a panel onto the second panel’s top or bottom border. When you
release the mouse button, the panel is docked in the new position.

To move a panel from a panel group, drag the panel’s tab and drop it in a
new location.

Undocking and docking a panel group
In the Mac version of Flash, panel groups always float. However, in the
Windows version, panel groups are normally docked at one side of the appli-
cation window. To undock and create a floating panel group, simply drag the
group into the Document window. The panel group undocks and floats on
top of the workspace.

Figure 1-10:
Use panels
arranged as
tabs you
minimize
screen real
estate.
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To redock the panel group, drag it to the side of the application window that
you want to dock. Flash then redocks it.

Saving a workspace layout
After you arrange the workspace the way you want, choose Window➪
Workspace➪Save Current from the menu. In the Save Workspace Layout
dialog box, give your new, customized workspace a name and click OK. 
The new layout is added to the Workspace list.

To use a workspace, choose Window➪Workspace and select a layout from
the list.
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